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Introduction





UNIPAS( (UNcertainties In PAleoSeismology), is a computer software to evaluate the uncertainties in paleoseismology in a systematic and effective way and is based on the recently introduced method of Atakan (1997; in review). The UNIPAS software was developed around the idea that the uncertainties related to the interpretation of the paleoseismic data need to be evaluated and reported prior to the usage of such data in the seismic hazard analysis. The common procedures applied in the treatment of uncertainties in probabilistic seismic analysis do not account for the uncertainties related to the entire paleoseismic investigation. What is usually included and accounted for is the numerical uncertainties attached usually to the age determination of a paleo-earthquake(s). The method applied in UNIPAS (Atakan, 1997, in review), aims to account for the uncertainties related to the interpretation of the paleoseismic data. In order to achieve this, a qualitative procedure was applied, which makes use of quality weight factors (QWF) attached to each consecutive stage of the investigation. The cumulative uncertainty associated with the entire investigation is then assessed by using a logic-tree formalism.





UNIPAS is developed using the Visual C++ (Ver.5.0) programming language with the Microsoft( “Visual Developer Studio 97” and contains most of the common features of the window applications. The interactive process between the user and the program is based on dialog boxes with several items such as, button, edit-box, list-box, etc., making easy to use the program. 





The user manual describes how the installation process is done and what are the technical requirements needed to execute the program. In addition, a detailed description about the options and associated components of the program is given. In order to understand the functions of the different options, several figures are included, illustrating the dialog boxes involved in the running process.





UNIPAS can be obtained by contacting <atakan@ifjf.uib.no> and is available for non-commercial use for research purposes.





Installation and technical requirements 





UNIPAS does not require a complicated installation process. The only requirement is that all the UNIPAS system files have to be copied in the same directory of the hard disk. There is not a specific installation program. The UNIPAS files are compacted with pkzip program and the steps to follow in the installation process are described below.





1.- Insert the floppy disk with UNIPAS in drive A


2.- Create a directory called UNIPAS in drive C


3.- Go to the newly created directory UNIPAS


3.- Run the following command:    


      pkunzip  a:\unipas.zip  c:\unipas\


            


UNIPAS consists of 7 individual files, which are described below.





Unipas.exe�
Executable program of the system�
�
Unipas.hlp�
Help of the system (File 1)�
�
Unipas.cnt�
Help of the system (File 2)�
�
Unipas.par�
Configuration file of the quality weigh factors�
�
Unipas.pqf�
Configuration file of the paleoseismic quality factor�
�
Mfc42.dll�
Dynamic link library of Microsoft Windows(          �
�
Msvcrt.dll�
Dynamic link library of Microsoft Windows(       �
�



In addition, there are several example files included (e.g. Unipas1.ups) in the standard distribution to illustrate different applications. The technical requirements to execute UNIPAS are the following:





A standard IBM(-compatible PC with Microsoft Windows( 95 operating system or higher


Hard Disk memory available of 2 Mbytes


Mouse (recommended)





Basic philosophy of UNIPAS





The basic philosophy of UNIPAS is to provide a simple and flexible computer software that can be used in evaluating the uncertainties in paleoseismology. UNIPAS allows the user to configure the system in a desired way, which can be done by filling in appropriate values for the quality weight factor (QWF) categories used for the different stages of a paleoseismic investigation. In this respect, the QWF values suggested in Figures 25-32 are included in the software as default values. These values are only meant as examples and the user is free to enter any specific QWF value in the different categories. However, it is assumed that once the system is configured with the desired QWF values, the same configuration will be used for all consecutive investigations. Otherwise there will not be any room for comparison of different investigations performed earlier and if such a comparison does not exist, it would be difficult to establish a relative scale to evaluate the uncertainties. It is therefore strongly recommended that the user configures the system prior to the analysis of the uncertainties and once this is done, the same configuration is applied to all consecutive analyses. This is clearly an advantage which allows systematic treatment and comparison of uncertainties in paleoseismology and hence providing a possibility to create a relative qualitative scale.





Getting Started





Following is a brief description of a preferred sequence of steps in using the UNIPAS software:





  Configure your system by using <Config> command from the main menu (using QWF) and enter appropriate values for the outlined categories.


  Go through the individual stages of paleoseismic investigation (i.e. nodes) in the program by using the <Select> button for each node and select the relevant QWF from the pop-up window based on the predefined tables (either configured by the user or predefined as default by the UNIPAS).


  Create the logic-tree (TREE) and the frequency distribution of the probabilities (BAR-GRAPH) using the <Evaluate> button. More information on the different stages of investigation can be obtained by clicking with the left mouse button on the relevant node on the TREE.


  Select an appropriate importance level (Cri) using the <PQF> (Paleoseismic Quality Factor) button. The program automatically calculates and shows the PQF value in the adjacent box.


  Check on the BAR-GRAPH whether the computed alternative end-solution on the logic-tree (TREE) corresponds to the highest value. If not, the user may click with the left mouse button on the relevant bar to display the corresponding combination of paths with the QWF values. 


  Save the analysis results in to a file (with extension .ups).


  Re-run the program with refined values of QWF or adding more branches on each node and calculate the new alternative end-solution and the new PQF.


  Save the new results in to a file (with extension .ups).


  Open the previously saved file and compare the results.


  Repeat the above steps until you are satisfied with the results.


  Save the final results in to a file and print out the logic-tree and the bar graph.





Brief description of the main functions of UNIPAS





UNIPAS is a software developed with the most common options of the window's application. It includes a set of commands related with the archives manipulation (open, save, print, etc.) and dialog boxes for the user-program interaction. Multiple files can be edited at the same time in separate windows and copies to clipboard can be done. The editing of a UNIPAS analysis file (with the extension ‘ups’ e.g. unipas1.ups) is done by a window divided in 4 sections (Fig. 1). The upper left corner section includes the input data (quality weight factor, QWF) entry dialog boxes for each of the stages of paleoseismic investigation (i.e. Nodes), with the corresponding branches. For each node there is a possibility of having up to four alternative branches with QWF values. The branch values are valid for the activated node and can be entered by using the four edit-boxes. The program automatically calculates the following branch value such that the sum of the branch QWF’ s is equal to 1. The two arrow boxes (left and right) are used for navigating between the different nodes.
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Figure 1. Main layout of a typical UNIPAS window corresponding to an analysis file.





Immediately below the arrow buttons there are 3 click buttons with specific functions. A brief description of these buttons is given below (see section 1.1 User Manual):





The <Select> button is used for the selection of the quality weight factors (QWF) corresponding to each stage of investigation (i.e. Nodes). A separate dialog box appears in which the user can choose the relevant category (Fig.2). The program automatically enters the lowest value for the branch1 among the given range of QWF’ s for the chosen category. The QWF values for the different categories that appear in the separate dialog boxes for each node can be configured prior to the analysis using the <Config> command on the main menu of the program.





The <Evaluate> button updates all sections of the window. The alternative end-solutions for the individual paths are shown in the list-box on the lower left corner section. The TREE and GRAPH BAR graphics are drawn on the upper- and lower-right sections.





The <PQF> button selects the level of importance of the investigation in the seismic hazard analysis and calculates the Paleoseismic Quality Factor (PQF).
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Figure 2. An example of a Dialog Box for the relevant category selection corresponding to the Tectonic Setting.





On the TREE graph, you can get help about the definition of the different stages (nodes) if you place the mouse above the label that identify it and click the left button.





If you want to see the results of a different path combination in the logic-tree, you may click the left button over the desired bar in the BAR GRAPH. For the chosen probability level on the BAR GRAPH the results will be displayed on the TREE graph.





The quality weight factors at each stage of the investigation are based on the user’s definition. This can easily be entered at the <Config> menu (See section 5.1 of the User Manual), where the QWF values are set (Fig. 3).
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Figure 3.  Configurations of quality weight factors for tectonic setting.





Main Menu





UNIPAS starts with a window that involves a main menu with an associated tool bar located on the upper part of the window  (Fig. 4). The main menu contains 6 general options (File, Edit, View, Window, Config and Help)  and each one of them includes a set of commands with  specific functions. The Tool Bar with relative icons include buttons that are used for executing the most common commands of the program. 
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Figure 4.  Main window of UNIPAS





At the bottom of the window a Status Bar is shown, which describes the action to be executed by the selected menu item or depressed toolbar button, and keyboard latch state.


UNIPAS  always opens a new file (temporarily named Unipas1.ups)  when it is started. The new working file is initialized with default values (zero).





Commands of the main menu





 1. File menu





The File menu includes the standard options related to the file manipulation (Fig. 5) and it offers the following commands:





New�
Creates a new UNIPAS analysis file.�
�
Open�
Opens an existing analysis file.�
�
Close�
Closes an opened analysis file.�
�
Save�
Saves an opened analysis file using the same file name.�
�
Save As�
Saves an opened analysis file to a specified file name.�
�
Print�
Prints an analysis file.�
�
Print Preview�
Displays the analysis file on the screen as it would appear printed.�
�
Print Setup�
Selects a printer and printer connection.�
�
Exit�
Exits UNIPAS.�
�
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Figure 5. Commands of File menu.





1.1- <New > command (File menu)





Use this command to create a new analysis file in UNIPAS. The user can modify the analysis file by using the different edit-boxes and buttons that are include in the window shown in figure 6. In fact the figure 6 shows an existing analysis file because a new analysis file does not have a graph drawn on the screen. 
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Figure 6.  The layout of a UNIPAS analysis file window with basic functions.





You can introduce the data using the Edit Box labeled as branch1, branch2, branch3 and branch4. When you type the data (QWF value), the next branch will be filled automatically because the sum of branches at each node must be 1. The data values are valid between 0 and 1.





UNIPAS performs the validation automatically. You can navigate through the different branches by using the TAB key and through the different nodes (stages of investigation) by typing RETURN or pressing arrows button. In addition, you can use the Combo Box to navigate between  different  stages.





The <Evaluate> buttons displays the calculation results together with the TREE and GRAPH BAR graphics. You can activate this action pressing this button or typing Alt+E.





The <PQF> button selects the level of importance of the investigation in the seismic hazard analysis in order to calculate the Paleoseismic Quality Factor. A separate menu appears and the user may choose the level accordingly (Fig. 7). Clicking the <OK> button will compute the Paleoseismic Quality Factor.
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Figure 7. Selection of importance level





The <Select> button is used for the selection of the quality weight factors (QWF) corresponding to each node (i.e. stage of investigation). A separate dialog box appears where you may choose the relevant category (Fig. 8,9,10,11,12,13,14). The quality weight factor at each stage of investigation is based on the users definition. This can easily be entered at the <Config> menu (See section 5.1), where the parameter setting for QWF are set. The program automatically chooses the lowest value for the branch1 among the given range of QWF and fills the edit-boxes (branches) that correspond at involved node.





On the TREE graph, you can get help about the definition of the different stages (nodes) if you place the mouse above the label that identify it and click the left button.





If you want to see the results of a different path combination in the logic-tree, you may click the left button over the desired bar in the BAR GRAPH. For the chosen probability level on the BAR GRAPH the results will be displayed on the TREE graph. The modifications done on the screen will not be overwritten on the original file.
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Shortcuts


Toolbar:	





Keys:	    CTRL+N
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Figure 8. Dialog Box for the relevant category selection of Tectonic Setting.
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Figure 9. Dialog Box for the relevant categories of Site selection.





The figures 10 and 11 belong at the same investigation stage, so the <Select> button  will show only one of them depending of which one is selected as active in the <Config> menu (See section 5.1).
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Figure 10. Dialog Box for the relevant category selection of Extrapolation of data (User defined).
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Figure 11. Dialog Box for the relevant category selection of Extrapolation of data (TFR).
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Figure 12. Dialog Box for the relevant category selection of Identification of Paleoearthquake.
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Figure 13. Dialog Box for the relevant category selection of Dating of Paleoearthquake.
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Figure 14. Dialog Box for the relevant category selection of Paleoearthquake size estimation.








1.2- <Open > command (File menu)





Use this command to open an existing analysis file in a new window. UNIPAS displays the file open dialog box. (Fig. 15). You can open multiple analysis files and work with several files simultaneously.  Use the Window menu to switch among the multiple opened analysis files.  See Window 1, 2, ... command.
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Shortcuts


Toolbar:	





Keys:	CTRL+O
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Figure 15.  File Open dialog box 





The following options allow you to specify which analysis file to open:


File Name


Type or select the filename you want to open.  This box lists files with the extension you select in the List Files of Type box. 


List Files of Type


Select the type of file you want to open:


Look in


Select the drive or directory in which UNIPAS stores the file that you want to open. 


 


1.3- <Close > command (File menu)





Use this command to close all windows containing the active analysis file.  UNIPAS suggests that the user saves changes to the analysis file before it is closed.  If the analysis file is closed without saving, all changes made since last time will be lost.  Before closing an untitled analysis file, UNIPAS displays the Save As dialog box  (Fig. 16) and suggests that the analysis file is named and saved.





You can also close an analysis file  by using the Close icon on the analysis file window, as shown below:
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1.4- <Save >command (File menu)





This command is used to save the activated analysis file to its current name and directory. When you save an analysis file for the first time, UNIPAS displays the Save As dialog box  (Fig. 16), so you can name your file. If you want to change the name and directory of an existing file before saving it, choose the Save As command.
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Shortcuts


Toolbar:	





Keys:	CTRL+S





1.5- <Save As > command (File menu)





This command is used to save and rename the activated analysis file. UNIPAS displays the Save As dialog box (Fig. 16) , and the desired file name can be entered.  





To save an analysis file with its existing name and directory, use the Save command
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Figure 16. File Save As dialog box





The following options allow you to specify the name and location of the analysis file you're about to save:


File Name


Type a new analysis file name to save a file with a different name.  A file name can contain up to eight characters and an extension of up to three characters.  The preferred extension is ‘.ups’.


Save as type


UNIPAS adds the extension you specify in the Save File As Type box.


Save in


Select the drive or directory in which you want to store the analysis file.





1, 2, 3, 4 command (File menu)





Use the numbers and file names listed at the bottom of the File menu to open the last four analysis files activated.  Choose the number that corresponds to the analysis file you want to open.





1.6- <Print > command (File menu)





Use this command to print an analysis file. This command shows a Print dialog box (Fig.17), where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options.





� INNEBYGG Paint.Picture  ���


Shortcuts


Toolbar:	





Keys:	CTRL+P
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Figure 17.  Print dialog box





The following options allow you to specify how the analysis file should be printed:


Printer


This is the active printer and printer connection.  Choose the Setup option to change the printer and printer connection.


Properties


Displays a Print Setup dialog box, (Fig. 19), so  you can select a printer and printer connection.


Print Range


Specify the pages you want to print:


All�
Prints the entire file.�
�
Selection�
Prints the currently selected text.�
�
Pages�
Prints the range of pages you specify in the From and To boxes.�
�
Copies


Specify the number of copies you want to print for the above page range.


Collate Copies


Prints copies in page number order, instead of separated multiple copies of each page.





1.7- <Print Preview > command (File menu)





Use this command to display the active analysis file as it would appear when printed.  When you choose this command, the main window will be replaced with a print preview window in which one or two pages will be displayed in their printed format (Fig. 18).  The print preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a print job.
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Figure 18. Print Preview Window





The print preview toolbar offers you the following options:


Print


Bring up the print dialog box, to start a print job.


Next Page


Preview the next printed page.


Prev Page


Preview the previous printed page.


One Page / Two Page


Preview one or two printed pages at a time.


Zoom In


Take a closer look at the printed page.


Zoom Out


Take a larger look at the printed page.


Close


Return from print preview to the editing window.





1.8- <Print Setup > command (File menu)





Use this command to select a printer and a printer connection.  This command presents a Print Setup dialog box, (Fig. 19), where you specify the printer and its connection.
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Figure 19.  Print Setup dialog box





The following options allow you to select the destination printer and its connection.


Printer


Select the printer you want to use.  Choose the Default Printer; or choose the Specific Printer option and select one of the current installed printers shown in the box.  You install printers and configure ports using the Windows Control Panel. 


Orientation


Choose Portrait or Landscape.


Paper Size


Select the size of paper for the file to be printed.


Paper Source


Some printers offer multiple trays for different paper sources.  Specify the tray here.


Properties


Displays a dialog box where you can make additional choices about printing, specific to the type of printer you have selected.





1.9- <Exit > command (File menu)





Use this command to end your UNIPAS session.  You can also use the Close command on the application Control menu.  UNIPAS prompts you to save analysis files with unsaved changes.





Shortcuts


Mouse:	Double-click the application's Control menu button.





� INNEBYGG Paint.Picture  ���	





Keys:	ALT+F4





2- Edit menu





The Edit menu  (Fig. 20) offers the following commands:





Undo�
Reverse first editing operation.�
�
Copy to clipboard�
Copies data from an analysis file to the clipboard�
�
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Figure 20. Commands of Edit menu





2.1- <Undo > command (Edit menu)





Use this command to return back to the first editing action, if possible. The editing action is completed when the data are evaluated by pressing the <Evaluate> button.
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Shortcuts


Toolbar:	





Keys:	CTRL+ U	





2.2- <Copy to clipboard> command (Edit menu)





Use this command to copy either TREE or GRAPH BAR graphics into the clipboard.





Copying data to the clipboard replaces the contents previously stored there.
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Shortcuts


Toolbar:	               





Keys:	CTRL+ T    (Copy TREE)


CTRL+ B    (Copy GRAPH BAR)    





3- View menu





The View menu (Fig. 21) offers the following commands:





Toolbar�
Shows or hides the toolbar.�
�
Status Bar�
Shows or hides the status bar.�
�
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Figure 21. Commands of View menu





3.1- <Toolbar > command (View menu)





Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in UNIPAS, such as File Open.  A check mark appears next to the menu item when the Toolbar is displayed.





Toolbar
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The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar provides quick mouse access to many tools used in UNIPAS.





To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).





3.2- <Status Bar > command (View menu)





Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when the Status Bar is displayed.





Status Bar


� INNEBYGG Paint.Picture  ���





The status bar is displayed at the bottom of the UNIPAS window.  To display or hide the status bar, use the Status Bar command in the View menu.





The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus.  This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them.  If after viewing the description of the toolbar button command you wish not to execute the command, then release the mouse button while the pointer is off the toolbar button.





The right areas of the status bar indicate which of the following keys are latched down:





Indicator	Description


CAP	The Caps Lock key is latched down.


NUM	The Num Lock key is latched down.


SCRL	The Scroll Lock key is latched down.





4- Window menu





The Window menu (Fig. 22) offers the following commands, which enable you to arrange multiple views of multiple analysis files in the application window:





New Window�
Creates a new window that views the same file.�
�
Cascade�
Arranges windows in an overlapped fashion.�
�
Tile�
Arranges windows in non-overlapped tiles.�
�
Arrange Icons�
Arranges icons of closed windows.�
�
Window 1,2,...�
Goes to specified window.�
�
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Figure 22. Commands of  Window menu





4.1- <New > command (Window menu)





Use this command to open a new window with the same contents as the active window.  You can open multiple analysis file windows to display different parts or views of an analysis file at the same time.  If you change the contents in one window, all other windows containing the same analysis file will reflect those changes.  When you open a new window, it becomes the active window and is displayed on top of all other open windows.





4.2- <Cascade > command (Window menu)





Use this command to arrange multiple opened windows in an overlapped fashion. 





4.3- <Tile > command (Window menu)





Use this command to arrange multiple opened windows in a non-overlapped fashion.





4.4- <Arrange Icons > Command (Window menu)





Use this command to arrange the icons for minimized windows at the bottom of the main window.  If there is an open analysis file window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this analysis file window.





1, 2, ... command (Window menu)





UNIPAS displays a list of currently open analysis file windows at the bottom of the Window menu.  A check mark appears in front of the analysis file name of the active window.  Choose an analysis file from this list to make its window active.  





5- Config menu 





The Config menu (Fig. 23) offers the following commands:





QWF�
Set a quality weight factors range for each node (i.e. stage of investigation) �
�
Correction term�
Set a correction term for the paleoseismic quality factor calculation�
�
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Figure 23. Commands of  Config menu





5.1- <QWF > command (Config menu)





Use this command to configure a quality weigh factors range that will be used for the input data selection (<Select> button of Edit  Window shown in figure 6) . You can select the stage of investigation to configure by pressing the buttons that identify each one of them (Fig. 24). The <Save> button allow  you overwrite or create the configuration file (unipas.par) with the values of the quality weigh factors .   
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Figure 24. Window for the selection of the investigation stage to configures





Separate windows for each one of the stage of investigation (node) are shown (Fig. 25,26,27,28,29,30,31,32). The quality weigh  factors (QWF) range are initialized with the values stored in the configuration file (unipas.par). If  unipas.par is missing, the QWF range will be initialized by defaults. Use the Tab key to navigate through the different edit-boxes or by clicking over them. The data values are valid for values between 0 and 1 and a automatic checking of them is done. The configuration of the investigation stage of extrapolation of data is done through a dialog box (Fig. 27), where the user chooses one of the two possibilities for configuration. 
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Figure 25.  Configuration of quality weight factors for tectonic setting.
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Figure 26.  Configuration of quality weight factors for site selection criteria.
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Figure 27.  Dialog box  for the selection of data characteristic.
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Figure 28.  Configuration of quality weight factors for extrapolation of data.
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Figure 29.  Configuration of quality weight factors for extrapolation of data.
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Figure 30.  Configuration of quality weight factors for Identification of Paleoearthquake.
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Figure 31.  Configuration of quality weight factors for Dating of Paleoearthquake.
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Figure 32.  Configuration of quality weight factors for Paleoearthquake size estimation.





5.2 - <Correction term > command (Config menu)





Use this command to set  a correction term corresponding at each one of the importance level that will be used for the Paleoseismic Quality Factor calculation (Fig. 33). The <Save> button allow  you to create or overwrite the configuration file (unipas.pqf) with the values of the correction term. If  unipas.pqf is missing, the correction term values will be initialized by defaults. 
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Figure 33. Configuration of the correction term criteria





6- Help menu





The Help menu offers the following commands (Fig.34), which provides assistance in using the UNIPAS: 





Help Topics�
Offers you an index to topics on which you can get help.�
�
About�
Displays the version number of the UNIPAS.�
�
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Figure 34. Commands of  Help menu





Some online help may also be displayed by clicking with left mouse button on the standard UNIPAS file window on the TREE and BAR GRAPHs. Additionally, pressing F1 will give help on the main functions of UNIPAS.





6.1- Help Topics (Help menu)





Use this command to display the opening screen of Help (Fig. 35).  From the opening screen, you can jump to step-by-step instructions for using UNIPAS and various types of reference information.  





Once you open Help, you can click the Contents button whenever you want to return to the opening screen.
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Figure 35. Help topics of the system





Context Help command 





Use the Context Help command to obtain help on some portion of UNIPAS.  When you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.  Then click somewhere in the UNIPAS window, such as another Toolbar button.  The Help topic will be shown for the item you clicked.





� INNEBYGG Paint.Picture  ���


Shortcut


      Toolbar





Keys:	SHIFT+F1





6.2- About command (Help menu)





Use this command to display the copyright notice and version number of your copy of UNIPAS.


�



File Format of a standard UNIPAS file





The used file format is an ASCII file. It is divided in four blocks: (i) data matrix, (ii) selected level for the seismic hazard evaluation, (iii) data selection made by the user, and (iv) Alternative end-solutions derived from the different path of the tree calculation.





Following is an example of a UNIPAS file (filename.ups):








Data matrix for the selected quality weight factors (QWF) (rows indicate branches and columns indicate nodes)





0.23   0.60   0.80   0.80   0.80   1.00   


0.77   0.40   0.20   0.20   0.20   0.00   


0.00   0.00   0.00   0.00   0.00   0.00   


0.00   0.00   0.00   0.00   0.00   0.00   





Importance Level, Correction term and Paleoseismic Quality Factor (PQF)





2   4   0.2826





Selected categories for different stages of investigation





1 Tectonic Setting


2 Site Selection


2 1 Extrapolation of data


1 Identification of paleoearthquake


1 Dating of paleoearthquake


1 Paleoearthquake size estimate





Alternative end-solutions for different paths in the tree





0.0707  0.0177  0.0177  0.0044  0.0177  0.0044  0.0044  0.0011


0.0471  0.0118  0.0118  0.0029  0.0118  0.0029  0.0029  0.0007


0.2365  0.0591  0.0591  0.0148  0.0591  0.0148  0.0148  0.0037


0.1577  0.0394  0.0394  0.0099  0.0394  0.0099  0.0099  0.0025











The first block of the file beginning at line 3, stores the quality weight factors selected by the user in the different stages of investigation (node). It is a matrix with columns indicating nodes and rows indicating branches.





The second block (line 10) contains the importance level and correction term (first and second column) used in the calculation of paleoseismic quality factor, PQF (third column).





The third block (line 14) stores the relevant category of the quality weight factor chosen by the user. The selection is done by using the dialog box associated with the <select> button of the Edit window shown in Figure 3 (See section 1.1). The first column indicates the index of the selection and the second the name of the investigation stage. The third row of this block has two indexes because in this stage the relevant category of the quality weight factor (QWF) can be selected using two different criteria. The first column indicates the selection of the criteria and the second column indicates the selection of the QWF category (i.e. the relevant TFR category). 





The last block (line 23) contains the alternative end-solutions for different paths of the logic-tree used for the uncertainty analysis and are expressed in terms of probabilities.
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